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Welcome to the 1 5th issue of The MagPi.

Are you bored of school hol idays or just want some down time after a hard day at work? This month's

issue has something for everyone! We take a look at the 'Multiple Arcade Machine Emulator' and reflect

back at some of the arcade history's greatest games, describing how you can turn your Pi into a retro

gaming console!

I f that's not enough, we delve deeper into the the partnership made in heaven, The Raspberry Pi -

Arduino double act. We look at connecting the two and even the possibi l i ty of control l ing your Arduino

from the command line+

James Hughes discusses advanced usage of the camera module and we publish more on Cocktai l

MegaPower and Pi Matrix, where Bruce Hall describes how to produce lighting routines for this clever

piece of kit+

We are excited to start you on an epic journey towards making your own operating system in the first in

a series by Martin Kalitis titled 'Bake your own Pi fi l l ing ︌ +

We are proud to introduce yet another language to our readers, XML, along with more from favourites

Assembler and Python+

On top of al l this, as always, we keep you up to date with Raspberry Pi events across the world. Phew!

That's a lot to get your teeth into. We better get started. Enjoy!

Ash Stone

Chief Editor of The MagPi



3

4 USB ADRDUINO LINK
U sing N anpy to connect your Raspberry Pi to An Arduino

8
U sing the I no command line toolkit

9
Part 2: Advanced Operation

1 6
Raspberry Pi timekeeping with a real time clock

1 8
Part 3: Bui lding a toolkit of patterns

20
MAME - MULTIPLE ARCADE MACHINE EMULATOR
Play historic games on the Raspberry Pi

24 <XML />

Part 1 : an introduction to XM L

30
Part 2: Low-level coding

40 FEEDBACK
H ave your say about The M agPi

COMMAND LINE ARDUINO PROGRAMMING

ASSEMBLY PROGRAMMING WITH RISC OS

1 0

A COCKTAIL OF EXPANSION BOARDS

THE RASPBERRY PI CAMERA MODULE

Part 4: M egaPower: DC-DC converter and an ATmega328 M CU
1 4

THE RASCLOCK

PI MATRIX

28
Part 1 : Bake your own Pi fi l l ing
MY OS: BUILD A CUSTOMISED OPERATING SYSTEM

33
Preston, M anchester, Powys, Gateshead
THIS MONTH'S EVENTS GUIDE

36
An introduction to Python iterators and generators
THE PYTHON PIT

Charm Programming on the Raspberry Pi
BOOK REVIEW35

http://www.themagpi.com

ContentsContentsContents

http://www.themagpi.com


4

DIFFICULTY : INTERMEDIATE

Tony Goodhew

Guest Writer

USB ARDUINO LINK
Add analogue ports to your Pi

Using Nanpy to connect your
Raspberry Pi to an Arduino

I f you have been using your Raspberry Pi with LEDs

and switches from Python and wish to progress to the

next level (reading analogue values and adjusting

output voltages with PWM) then using an Arduino as

a cheap and expandable input/output board is a good

option, whi le sti l l using Python. (You also gain a

board that can be used on its own to control robots

which you program from your Raspberry Pi) . This

uses a very safe USB connection al lowing the two

computers to communicate in both directions. The

Arduino provides an extra 1 4 digital pins (0 – 1 3), six

of which have PWM faci l i ties and six analogue pins

(1 0 bit, range 0-1 023, A0-A5) which can also be used

as digital I /O pins. An Arduino Uno R3 costs less than

your Raspberry Pi and you do not have any soldering

to do!

Preparing the SD card

You wil l need a 4 GB class 4 card (slow). Copy the

latest version of Raspbian Wheezy onto it and

expand the root partition. Then reboot the Raspberry

Pi.

Install setuptools

You need python setuptools to instal l nanpy on your

card. This is not in the current distribution, however

you can download it from the web.

Start the Midori web browser and type in the URL box

https://pypi.python.org/pypi/setuptools

Scrol l down to the Linux instructions and then on to

the downloads. We want the fi le:

setuptools-0.6c11-py2.7.egg

Click on it and you wil l be asked to open or download.

Click on SAVE. I t downloads very quickly. Once the

download has finished, close Midori and you should

see the egg fi le in the pi directory.

Next, open the LX Terminal and type in:

sudo sh setuptools-0.6c11-py2.7.egg

This is a very quick instal lation.

Install serialpy

Again, using the Midori web browser go to

https://pypi.python.org/pypi/pyserial . This time you

want to download pyserial-2.6.tar.gz.

However, this time you want to make a temp folder

and move the downloaded fi le into it - using

LXTerminal:

cd temp # Change to the temp directory

gunzip pyserial-2.6.tar.gz # to unzip it

tar –xvf pyserial-2.6.tar # to untar it

cd pyserial-2.6 # move into the new folder

sudo python setup.py install # to install it

The Raspberry Pi can now use serial communication.

https://pypi.python.org/pypi/setuptools
https://pypi.python.org/pypi/pyserial
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Install the Arduino software

To begin with, type ‘startx’ to start the GUI (unless

you set it to boot into the GUI automatical ly) . Then

open the LX Terminal and type in the the fol lowing

commands:

sudo apt-get update

sudo apt-get install arduino

Answer ‘Y’ when asked if you want to continue. This

instal lation takes some time…

You can now program your Arduino from the Arduino

IDE.

Install Nanpy

The next step is to download the nanpy fi les. You

could use wget, but I find it much easier to do on a

Windows PC and then transfer the unzipped folder to

the Raspberry Pi via a memory stick. On a PC, using

your web browser, navigate to the git repository

https://github.com/nanpy/nanpy and cl ick on the ZIP

button. This downloads the zipped directory to your

computer. Unzip it and copy the nanpy-master

directory via a USB stick to your pi directory.

Next, connect your Arduino via a USB cable to the

Raspberry Pi. Then open the LX Terminal and

navigate to the firmware directory in nanpy-master:

cd nanpy-master

cd firmware

export BOARD=uno

# (Type ‘make boards’ for a full list)

make

make upload # This also takes some time……

This RED section needs to be done each time you

connect the Arduino to the Raspberry Pi. I t loads the

Arduino part of nanpy into the Arduino. Now type:

cd .. # Move back to nanpy-master directory

sudo python setup.py install

This adds the Raspberry Pi part of nanpy to Python2

and only needs to be done once. You can now use

the Arduino as an I/O board for the Raspberry Pi.

This adds 20 extra I/O pins – 6 can be used for 1 0-bit

analog inputs (range 0-1 023) and 6 as PWM outputs

(range 0-255).

Testing

The Arduino real ly needs to be connected via a

powered USB hub so that it does not take too much

power from the Raspberry Pi.

On your Arduino connect an LED in series with a

resistor (about 250 Ohm for protection) between pin

1 0 and ground. The longer lead of the LED, the

anode, goes towards pin1 0 and the shorter, the

cathode, towards GND. Pin1 0 al lows PWM (Pulse

Width Modulation).

From the LXDE GUI on your Raspberry Pi, start

LXTerminal once again and type:

sudo idle

With sudo you can run the program from the Run

menu in IDLE. Click on Fi le, then New window (to

open a new window) and type in the fol lowing

program:

#!/usr/bin/env python

# LED with 250 Ohm resistor on Pin 10 to GND

# Tony Goodhew - 10 May 2013

from nanpy import Arduino

from nanpy import serial_manager

serial_manager.connect('/dev/ttyACM0') # serial connection to Arduino

from time import sleep

LED =10 # LED on Arduino Pin 10 (with PWM)

Arduino.pinMode(LED, Arduino.OUTPUT)

print"Starting"

print"5 blinks"

for i in range(0,5):

Arduino.digitalWrite(LED, Arduino.HIGH)

https://github.com/nanpy/nanpy
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sleep(0.5)

Arduino.digitalWrite(LED, Arduino.LOW)

sleep(0.5)

print"Changing brightness of LED"

bright = 128 # Mid brightness

Arduino.analogWrite(LED, bright)

Arduino.digitalWrite(LED,Arduino.HIGH) # Turn on LED

for i in range(0,200):

bright = bright + 8

if (bright > 200): # LED already full on at this point

bright = 0 # Minimum power to LED

Arduino.analogWrite(LED, bright) # Change PWM setting/brightness

sleep(0.05)

Arduino.digitalWrite(LED,Arduino.LOW) # Turn off LED

print"Finished"

Save and run the program from the IDLE menu.

Problem: I f you pul l the USB cable out of the Arduino

while the Pi is control l ing it you may need to re-boot

the Raspberry Pi before it wi l l re-connect. You may

also need to re-do the instructions in the 'Instal l

Nanpy' section if the firmware gets corrupted.

Reading a single switch

Digital pins with switches need to be held HIGH (at

5V) or LOW (at 0V) unti l a switch is closed. When the

user closes a switch the voltage of the pin changes to

the opposite state - HIGH to LOW or LOW to HIGH.

A 1 0K Ohm resistor is used to 'pul l ' the pin either

HIGH or LOW. This is exactly the same as putting

switches directly onto the Raspberry Pi 's GPIO pins.

The image below shows the circuit on a breadboard.

The wires connect to the Arduino: Red to 5V, black to

GND and the green wire to pin8. The fol lowing code

demonstrates how to read the switch value in Python.

#!/usr/bin/env python

# Button switch on pin 8

# with 10K ohm pull up resistor

from nanpy import Arduino

from nanpy import serial_manager

serial_manager.connect('/dev/ttyACM0')

button = 8 # Switch on pin 8

count = 0 # Initialise counter

# Set Button pin for input

Arduino.pinMode(button, Arduino.INPUT)

print "Press the button 3 times"

while (count < 3):

sw1 = Arduino.digitalRead(button)

#Wait until switch is pressed

while (sw1 == 1):

sw1 = Arduino.digitalRead(button)

count = count + 1

print count

#Wait until switch is released

while (sw1 == 0):

sw1 = Arduino.digitalRead(button)

print "Finished"

Thanks to Andrea Stagi for the software. See The

MagPi, issue 8, page 1 2 for more detai ls.

The next article wil l cover reading analogue ports and

driving a l iquid crystal display (LCD) so make sure to

come back for more Nanpy goodness!



http://shop.pimoroni.com


8

DIFFICULTY : INTERMEDIATE Nathan Bookham

Guest Writer

ARDUINO INO
Easi ly compile a sketch without a GUI

Command line Arduino programming

When I started getting into programming the

Arduino, I stumbled across a great l i ttle tool that

al lows you to program your Arduino from the

command line.

Ino (inotool.org) is a tool written in Python that

al lows you to easi ly compile an Arduino sketch

without using a GUI (graphical user interface) or

messing around with makefi les. I t runs on Linux

(as well as Mac, with Windows support coming

soon) which means that we can run it on the

Raspberry Pi.

Installing Ino

Ino is easy to instal l . Providing that you are

running the latest version of Raspbian and fol low

the instructions, you shouldn’t run into problems.

First of al l , run the command below to update the

apt repositories and to instal l any updates:

sudo apt-get -y update

sudo apt-get -y upgrade

After running this command, we need to instal l

dependencies. Run the fol lowing command:

sudo apt-get install arduino picocom

python-setuptools

After the dependencies have been instal led, use

Python’s easy_instal l command to instal l pip:

sudo easy_install-2.7 pip

Now we can use pip to instal l Ino and any Python

dependencies we need. To do this we run the

fol lowing command:

sudo pip install ino

Ino wil l now search the Python Package Index

and download the fi les it requires. I t wi l l

automatical ly instal l these packages as well .

To check that Ino has been instal led we need to

run a command to check that it can find the

l ibraries and hardware fi les:

ino list-models

I f a l ist of Arduino boards appear, you have

successful ly instal led it. I f you can’t see any

boards, make sure that the Arduino package is

instal led and up-to-date.

Using Ino

Ino is well documented - so if you get stuck have

a look at the quick start guide onl ine at
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Other expansion boards

http://inotool.org/quickstart or run ino --help.

To create a new sketch make a new folder using

mkdir:

mkdir Blink

Then open the Blink directory and use the Ino

command to create the fi les and directories to

create a sketch:

cd Blink

ino init

This creates two directories, src and l ib. You

place your .ino fi les in the src folder, and any

l ibraries that you reference to in the l ib folder.

When Ino initial izes the src directory, it

automatical ly creates a fi le cal led sketch.ino.

Once everything has been initial ised, you can

create an .ino fi le and use your favorite text editor

to write your sketch. You can use nano, vim, or

any other text editor. Remember to place l ibraries

in the l ib folder, not the src folder.

Once you have created a sketch, we need to

bui ld it. I f you use a board other than the Uno, be

sure to change the board model. The Ino

quickstart page shows you how to do this.

We need to change directory to the Blink folder,

and then bui ld it:

cd ..

ino build

Just wait a few moments while it compiles your

sketch. Once done, you can upload it to your

Arduino board. You can do this with the upload

command:

ino upload

Ino is clever and can automatical ly detect which

serial port your Arduino is on.

Once uploaded, that’s it!

To view the serial output of your Arduino, just

use the fol lowing command:

ino serial

Connecting an Arduino to a Raspberry Pi opens

up a range of possibi l i ties, with a large range of

possible Arduino shields that can be added to a

setup. There is a l ist of some of the boards at

http://playground.arduino.cc/Main/HomePage

The list of boards avai lable that can be directly

connected to the Raspberry Pi is also increasing.

For a summary of some of the possible extension

boards, take at look at

http://el inux.org/RPi_Expansion_Boards

There are cards to al low the Raspberry Pi to be

connected to batteries instead of the mains,

several different LED boards, buzzers, and motor

control lers. There are expansion boards to add

other ports, such as RS232 or single wire

interfaces. There are servo control lers and

robotics boards. There is also a long l ist of

multifunction boards, al lowing several different

signals to be read or written.

This month a FPGA (field programmable gate

array) development board arrived in the post

from ValentFx. The board needs some

additional developers to bring its software up to

speed. Please get in touch with the editor if you

would be wil l ing to help.

http://inotool.org/quickstart
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DIFFICULTY : BEGINNER James Hughes

Guest Writer

ADVANCED OPERATION
Go pro with the camera module

The Raspberry Pi camera - part 2

Welcome back to part two of The MagPi mini

series covering the fantastic Raspberry Pi

camera module.

In part one we covered setting up your camera

and it's basic operation. In this issue we begin to

introduce you to some of the advanced features

that the module is capable of, al lowing you to

capture images l ike a professional.

Sizing options

Lets begin by looking at sizing options. You can

easi ly specify the size of your captures using the

-w (--width) and -h (--height) options. These do

exactly what you might expect - they change the

resolution of the resultant captures (either sti l ls or

video). But you can also change the quality of the

JPG sti l ls using -q (--qual ity) and the quality of

the H264 encoding using -b (--bitrate). Both

these formats use what is known as lossy

compression, that is they throw away detai l in

order to compress the fi les. The more detai l that

is thrown away, the smaller the fi le, i t’s simply a

tradeoff between quality and fi le size.

Some examples..

raspistill -w 640 -h 480 -q 10 -o smallpic.jpg

raspivid -w 640 -h 480 -b 500000 -o \

smallvid.h264

The bitrate option is measured in bits per

second. So in the example above, 500000 is

0.5Mbits/s. The is quite a low bitrate for 1 080p

video, but good enough for the small image size

requested here. Ful l HD recording (the default) is

supported, which is 1 920x1 080 at 30 frames per

second (abbreviated to 1 080p30), this requires a

higher bitrate to avoid odd compression

artefacts. I t’s well worth trying out various

bitrates just to see how it affects the image

quality. I t’s sometimes very surprising how low

you can go before the video becomes

unwatchable!
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raspivid -t 10000 -b 1000000 -o \

highcompression.h264

In fact, the raspisti l l appl ication al lows us to save

in 4 different fi le formats, although JPG is by far

the fastest (and most common). The other

formats supported are PNG, GIF and BMP.

These are al l lossless formats (no data is thrown

away in order to decrease fi le size), and the fi le

sizes are therefor much larger than JPG. They

also take longer to save as there is no dedicated

hardware acceleration in the GPU for them. You

can select the type of fi le to output using the -e (-

-encoding) options.

raspistill -t 1000 -e png -o image.png

Timelapse mode

The raspisti l l app has a very useful feature cal led

timelapse mode. Instead of just taking one

picture, it takes sequence of pictures at a

specified interval (use - tl) , unti l the timeout l imit

(-t)   is reached. So, to take a picture every 5

seconds over a period of 50 seconds, use the

fol lowing.

raspistill -t 50000 -tl 5000 -o image%d.jpg

The -t and -tl options are fairly obvious - but

what’s that odd fi lename specification? Well , i f

you just specified something l ike

raspistill -t 50000 -tl 5000 -o image.jpg

then al l you pictures would be saved the the

same fi lename, image.jpg. So you end up with

just one picture! By adding a %d in your fi lename

specifier, the image number is added to the

fi lename at the place where the %d is. So our

first example above would save a set of fi le as

image1 .jpg, image2.jpg.. . image1 0.jpg. In fact,

the fi lename is generated uses the same

formatting as the C language printf statement, so

you can do something l ike this..

raspistill -t 50000 -tl 5000 -o image%04d.jpg

which specifies the number wil l be formated as 4

digits long and use preceding 0’s to pad out

those 4 digits, resulting in image0001 .jpg,

image0002.jpg.. . image001 0.jpg being saved.

See the printf format specifier documentation

(man printf on a console command line) for more

information.

Changing image parameters

Just l ike a compact  camera, there are lots of

options that can be applied to the images to

change their effect, or the way they were taken.

The fol lowing options are equally applicable to

sti l ls or video mode. Also note that some options

may not be ful ly implemented at this stage, and

you may see no effect when using them. This is

because the applications were written to the

ful l   Camera  API (application programming

interface) avai lable, not necessari ly what was

actual ly implemented under that API . I ’m only

going to describe working features here. Feel

free to try al l the options to see the effect they

provide, and whether they actual ly do anything!

Firstly, we have the basic image operations.

These are sharpness (-sh [-1 00 to 1 00]) ,

contrast (-co [-1 00 to 1 00]) , brightness (-br [0 to

1 00] ) and saturation (-sa [-1 00 to 1 00]) . Al l

these settings are commonly found

on  cameras  or even LCD televisions. Try them

out with different numbers to see what effect they

have - here’s a start point.

http://youtu.be/GImeVqHQzsE
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raspistill -t 5000 -sh 100 -co 50 -br 25 \

-sa 50 -o image.jpg

Image effects (-ifx) are quite fun. These apply

interesting fi l ters to the image, l ike negative or

emboss. Only one effect can be applied at a

time, and the ful l set of effects avai lable are :

negative, solarise, sketch, denoise, emboss,

oilpaint, hatch, gpen, pastel, watercolour,

film, blur saturation, colourswap, washedout,

posterise, colourpoint, colourbalance and

cartoon.

raspistill -t 5000 -ifx negative -o image.jpg

The colour effects option (-colfx) is interesting.

Internal ly, the image is represented using a YUV

colour space. YUV represents colour using the

luminance, Y, and  blue–luminance and

red–luminance differences, UV. The colour

effects option al lows up to specify the values we

are going to use for U and V. This gives us a

quick and easy way to do black and white

images, we just need to set UV equally to the

middle of the range, which is 1 28. So

raspistill -t 5000 --colfx 128:128 \

-o image.jpg

Other values for U and V give varying blue and

red differences from the middle. Try some

numbers!

The final image options I ’m going to talk about

are more about how the picture is taken rather

than what processes are applied to the image.

These are metering mode (-mm) and awb mode

(-awb).

Metering mode specifies what area of the

incoming image is used for determining the

brightness of the image. Internal ly, there is a

target brightness that is required, and

the  camera  system adjusts the internal gain to hit

that target. But to do that it need to know what

brightness the incoming image is so it can be

boosted to the required level. The area of the

image that is used to determine that incoming

brightness is what is defined by the metering

mode. There are two useful ly distinct options:

average and spot. Spot takes the very centre of

the image and uses that, average uses the whole

image. So if you have a scene with a very bright

point in the centre, using spot wil l almost

certainly underexpose, so you should use

average in that case.

raspistill -t 5000 -mm average -o image.jpg

AWB stands for automatic white balance. This is

a complicated subject, but in very simple terms,

it’s the adjustment made to the image to

compensate for different l ighting conditions to

make whites look white. For example, different

types of office l ight produce different l ighting

conditions, and the system needs to compensate

for those conditions so the white walls sti l l look

white in the photograph. By default the awb

selection is done automatical ly uses Bayesian

analysis of the scene to make an educated guess

on the l ighting conditions. However, you can

specify the AWB approach being used

depending on the scene being captured. The

options are :

auto, sun, cloud, shade, tungsten,

fluorescent, incandescent, flash, horizon.

So to set up the AWB for a room lit by tungsten

fi lament bulbs :

raspistill -t 5000 -awb tungsten -o image.jpg



Anything else?

We’ve covered many of the features avai lable on

the Raspberry Pi   camera, but the best way to

find out about them is to play with the  camera,

adjust settings and see what happens. To help

with this there is a demo mode avai lable which

runs through a lot of the options automatical ly.

The fol lowing example runs for 1 minute,

changing an effect every 500ms (1 /2second)

raspistill -d 500 -t 60000

One option not mentioned is the abi l i ty to output

the image or video stream to stdout, so it can be

piped to other applications (for example, network

streaming). To do this, instead of specifying a

fi lename for the -o option, you use the - (hyphen).

The fol lowing example outputs the jpg data to

stdout, where it is passed on the the fi le

image.jpg. The effect is the same as specifying

-o image.jpg.

raspistill -o - > image.jpg

Final words

As with everything Raspberry Pi, the  camera  is

meant to be a learning experience. Many options

are avai lable for you to try out, some might be

useful, some not so useful. Try them out,

experiment, you cannot break it using any of the

options!

The source code for the applications is publicly

avai lable, and was written in a very

straightforward fashion (in C) with lots of

comments to make it easier for people to modify

it to their own purposes. Feel free to pi le in,

change stuff, see what it does. I f you add a great

new feature, make sure you post about it on the

Raspberry Pi forums - you never know, it might

make it in to the official applications!
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DIFFICULTY : ADVANCED Lloyd Seaton

Guest Writer

MEGA POWER
Adding an ATmega MCU

This constructional project is for hobbyists
who are confident with a soldering iron, who
like to have options and are prepared to
purchase their own components

Raspberry Pi continues to set new standards for
affordabi l i ty, accessibi l i ty, power and versati l i ty
but when the need arises to interface with "real
world" digital and analog signals, the Arduino
microcontrol ler platform offers significant
advantages. This project involves the
construction of a printed circuit assembly
(MegaPower) that can be used to expand the
Raspberry Pi 's capabi l i ties by inclusion of a
companion microcontrol ler, an ATmega328
MCU. MegaPower can also include a buck DC-
DC converter circuit to derive a 5V power supply
from a higher DC voltage for powering of both
MegaPower and Raspberry Pi. Alternatively,
MegaPower can be used in standalone mode,
connecting to Raspberry Pi only for initial
programming of an Arduino sketch. As a
constructor, the choices are yours to make!

The DC-DC buck converter components have
been omitted from the MegaPower unit
(opposite) as an economy measure but the
ATmega MCU provides plenty of digital I /O and
analog inputs for use by the Raspberry Pi and
there are 7 Darl ington outputs for driving relays
etc. Unl ike Gertboard's MCU, the MegaPower
MCU operates at 5V for ease of interfacing with
a wide range of conventional logic circuits.
Level shifting circuitry provides permanent
connections of SPI bus and UART to Raspberry
Pi so that no jumpers are required for
programming of Arduino sketches or for

intercommunication using the Firmata protocol.
Instead of mounting MegaPower on the
Raspberry Pi 's P1 connector via the grey 3M
socket, the constructor may prefer to connect via
ribbon cable, in which case header pins can be
fitted to the upper side of the PCB instead of the
3M socket underneath.

The MegaPower unit pictured above is complete
and being tested in standalone operation. The
heat sink (far left) is needed if MegaPower is
providing power for a Raspberry Pi Model B but
should not normally be required by a Raspberry
Pi Model A or for standalone operation. Near the
right edge of the PCB there is provision for 2 pul l-
up resistors (R6 & R7) that may be required by
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the I2C bus in standalone operation but should
not be fitted if operation with a Raspberry Pi is
intended. There are 4 LEDs, 2 of which indicate
activity of the UART and SPI bus respectively.
The other 2 LEDs are uncommitted and are
avai lable for general use by the programmed
Arduino sketch.

Construction Of MegaPower

Before commencing construction of MegaPower
it is important that you take the time to famil iarise
yourself with the design. By doing so you wil l
maximise the educational value of your project
and increase the l ikel ihood that you wil l make the
right configuration choices for your particular
needs. A comprehensive design description
document is avai lable via the information blog at
picocktai ls.blogspot.com (Issue 1 5 page). This
document includes a schematic diagram,
interface pinouts, a schedule of suggested
components and suppliers and other helpful
information. For constructors who are
reasonably proficient, the project is relatively
straight forward so long as it is approached with
a sensible amount of planning and care,
particularly with regard to component orientation.
When in doubt, check it out!

Programming the ATmega MCU

The MCU operates from its internal clock at
8MHz or 1 MHz so it is not immediately
compatible with the Arduino IDE on Raspbian.
However, compatibi l i ty is easi ly achieved.
    • Firstly, i t is necessary to instal l Gordon
Henderson's Arduino IDE extensions for
Gertboard (projects.drogon.net/raspberry-
pi/gertboard) which include the necessary
support for programming an ATmega via the SPI
bus and Raspberry Pi 's GPIO ports.
  • Secondly, you need to instal l the picocktai ls
extensions for the Arduino IDE by fol lowing the
procedure that is given on the Arduino page of
the blog at picocktai ls.blogspot.com .

I f you have already instal led either or both of the
above mentioned IDE extensions, you should
not instal l them a second time or the
consequences may be ugly. Having instal led
the IDE extensions you can activate the Arduino
IDE and select: Tools -> Programmer ->

Raspberri Pi GPIO. Then select: Tools -> Board
-> MegaPower w/ ATmega328P (8MHz internal
clock). Activate: Tools -> Burn Bootloader to
initial ise the ATmega fuses.

I f you succeeded in burning the bootloader
without error, i t is very l ikely that you'l l be able to
successful ly program an Arduino sketch. Try
programming the Blink sketch from File ->
Examples -> 01 .Basics -> Blink but you'l l need to
edit the sketch to use Pin 1 2 instead of Pin 1 3 for
control l ing the LED. Then use: Fi le -> Upload
Using Programmer to send the modified Blink
sketch to the MCU. After a surprisingly long
delay .. . the LED D4 should begin bl inking. You
can find further instructions on the (Issue 1 5
page) of picocktai ls.blogspot.com for
programming the StandardFirmata sketch and
running the pyfirmataManager.py test program.

Availability of PCBs

A fundamental goal of this series of articles is to
help constructors to acquire superior PCBs at
affordable prices so that they can better pursue
their interest in applying the unique capabil i ties
of the Raspberry Pi. Happi ly, there is now
another option when seeking PCBs for projects
such as MegaPower. The new WWW store, pi-
supply.com is planning to supply PCBs for
projects of this "cocktai l series" (including
MegaPower) and other projects in the near
future. PCBs for MegaPower (plus MegaMini
and MegaWire projects) wi l l hopeful ly be
avai lable by the time you read this.
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DIFFICULTY : BEGINNER

Jacob Marsh

ModMyPi

THE RASCLOCK
Get yours today from ModMyPi

Raspberry Pi timekeeping with
a real time clock

In order to achieve its miniature size and low

price tag, several non-essential i tems usual ly

found on a desktop computer had to be omitted

from the Raspberry Pi. Laptops and computers

keep time when the power is off by using a pre-

instal led, battery powered 'Real Time Clock'

(RTC). An RTC module is not included with the

Raspberry Pi, which instead updates the date

and time automatical ly over the internet via

Ethernet or WiFi. Subsequently, your Pi wi l l

revert back to the standard date and time

settings when the network connection is

removed. For projects which have no internet

connection, you may want to add a low cost

battery powered RTC to help your Pi keep time!

The RasClock has been specifical ly designed for

use with the Raspberry Pi and plugs directly in to

the Raspberry Pi 's GPIO Ports. This article wil l

walk you through its instal lation!

Step 1 - plug it in!

To avoid any damage to the module, make sure

your Raspberry Pi is switched off and the RTC

battery is firmly seated before instal lation. Plug

the coin battery into the RTC by matching the

positive on the battery with the positive on the

module and then plug the RTC into the

Raspberry Pi 's GPIO pins. I t sits on the 6 GPIO

pins at the SD card end of the Raspberry Pi.

Step 2 - set-up

This RTC module is designed to be used in

Raspbian. So the first step is to make sure you

have the latest Raspbian Operating System (OS)

instal led on your Raspberry Pi

(http://www.raspberrypi.org/downloads).

Currently the module requires the instal lation of a

driver that is not included in the standard

Raspbian distribution; however a pre-compiled

instal lation package is avai lable which makes

setup nice and easy.

Make sure your Pi has internet access and grab

the instal lation package off the internet from an

LXTerminal window:

wget

http://afterthoughtsoftware.com/files/linux-

image-3.6.11-atsw-rtc_1.0_armhf.deb

(The wget command allows you to grab a fi le off

the internet by providing a URL).

sudo dpkg -i linux-image-3.6.11-atsw-

rtc_1.0_armhf.deb

(The dpkg command enables the management

https://www.modmypi.com/rasclock-raspberry-pi-real-time-clock-module
http://www.raspberrypi.org/downloads
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of Debian packages. The -i instal ls the package,

or upgrades it i f i t is already instal led).

This may take a couple of minutes to complete.

sudo cp /boot/vmlinuz-3.6.11-atsw-rtc+

/boot/kernel.img

(The cp command stands for copy. Here, we

need to copy the RTC module's boot fi le to the

Raspberry Pi boot directory).

The next step involves editing the text in the

Raspberry Pi boot fi les. I usual ly use nano text

editor for these minor changes - it’s basic, pre-

instal led and easy to master. System commands

for nano are enabled by holding the CTRL key

(denoted as ^ in nano) whi lst pressing the

relevant command e.g. CTRL+X to exit.

We need to configure Raspbian to load the RTC

drivers at boot by adding the boot information to

the /etc/modules configuration fi le:

sudo nano /etc/modules

(This wil l open the 'modules' fi le within nano text

editor and al low you to make changes. To add

text simply use the arrows keys to browse to the

next l ine in the boot fi le and add the fol lowing

text, one per l ine. Then exit nano (CTRL+X) and

don't forget to save those changes!

i2c-bcm2708

rtc-pcf2127a

The final step in set-up is to register the RTC

module when the Raspberry Pi boots and set the

system clock from the RTC. When editing fi les

always fol low the instructions outl ined at the top

of the fi le denoted by #. For example, the fi le we

are just about to edit requires any text to be put

before the end of the fi le, denoted by 'exit 0'.

Open the required fi le for editing:

sudo nano /etc/rc.local

For Rev 1 . Raspberry Pi boards add the

fol lowing text:

echo pcf2127a 0x51 > /sys/class/i2c-

adapter/i2c-0/new_device

( sleep 2; hwclock -s ) &

For Rev 2. Raspberry Pi boards add the

fol lowing text:

echo pcf2127a 0x51 > /sys/class/i2c-

adapter/i2c-1/new_device

( sleep 2; hwclock -s ) &

Then reboot:

sudo reboot

Step 3 - using the RTC

After you reboot the Raspberry Pi you should be

able to access the module using the hwclock

command. The first time you use the clock you

wil l need to set the time. To copy the system time

into the clock module:

sudo hwclock –w

To read the time from the clock module:

sudo hwclock -r

To copy the time from the clock module to the

system:

sudo hwclock –s

That's it. . . you can now keep time using your

Raspberry Pi with no internet! Type hwclock into

your resident search engine for a load more

useful commands!

This article is
sponsored by
ModMyPi

All breakout boards and accessories used in this

tutorial are avai lable for worldwide shipping from

the ModMyPi webshop at www.modmypi.com

http://www.modmypi.com
http://www.modmypi.com


1 8

DIFFICULTY : MODERATE

Bruce E. Hall
W8BH

Guest Writer

PI MATRIX
Control an 8x8 matrix of 64 LEDs

Part 3: Building a toolkit of
patterns including Cylons!

Introduction

In Part 1 and Part 2 of this series, we looked at how

to bui ld the Pi Matrix and how to program simple

display routines in Python. In this tutorial we’ l l

develop those routines further, giving us a whole

toolkit of interesting displays to choose from.

Simplify, simplify

There are many ways to encapsulate data and code. I

decided to just make some useful functions that

anyone can grab and add to a project.

Let’s start with some low-level routines that write data

to the MCP2701 3 chip. In Part 2 we made a column-

writing routine to turn on a single column, l ike this:

def SetColumn (col):

bus.write_byte_data(ADDR,PORTB,0x00)

bus.write_byte_data(ADDR,PORTA,0x80>>col)

All of the routines that write to the chip wil l look l ike

this, writing byte values to one or more chip registers.

They work fine as is, but I decided to simplify them

further by taking out the repetitive parts, l ike this:

def Write (register, value):

bus.write_byte_data(ADDR, register, value)

def SetColumn (col):

Write (PORTB, 0x00)

Write (PORTA, 0x80>>col)

We don’t need to do this, but it moves al l of the I2C

calls to a single routine and removes the possibi l i ty of

sending some of our data to the wrong I2C bus

address. The simplest routine is one that writes data

to the LED column and row inputs. Once we write

that, we can further simplify SetColumn like this:

def WriteToLED (rowPins, colPins):

Write (PORTA, colPins)

Write (PORTB, rowPins)

def SetColumn (col):

WriteToLED (0x00, 0x80>>col)

Again, this abstraction is not necessary but helpful .

With WriteToLED we no longer have to remember

whether columns go on PORTA or PORTB. Try it!

Patterns

We sti l l have to remember that rows are active LOW

and that the column bits are reversed. Wouldn’t i t be

great to cal l a function with the first row bit and first

column bit set and have the top left LED light up? It’s

easy! We’l l use what we know and then never have

to remember it again:

def SetPattern (rows, cols):

WriteToLED(~rows, ReverseBits(cols))

The ti lde '~' negates the row bits, making them all

active LOW. We need to write a routine to reverse the

order of the column bits, but that’s al l i t takes. For

example, suppose we want to make a small 2x3
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rectangle. We need to set row bits 1 and 2

(0b000001 1 0 = 0x06) and column bits 1 , 2 and 3.

(0b00001 1 1 0 = 0x0E). Try cal l ing SetPattern with

some different bit patterns on the rows and columns

to see what you can make, including SetPattern(0,0).

Orientation

The cables around my Raspberry Pi hold it in an

upside-down orientation. By that, I mean the USB

ports are on the left and the GPIO pins are facing me

on the bottom. I was constantly turning my head

around, trying to see if the correct LEDs were l it.

Necessity is the mother of invention, so what would it

take to fl ip the display?

Things get a l ittle confusing here but when you fl ip a

display, up means down and left means right!

Something in the top-left, when fl ipped 1 80 degrees,

is now bottom-right. We can do this by reversing the

row and column bits:

def SetPattern180 (rows,cols):

SetPattern(ReverseBits(rows), \
ReverseBits(cols))

We can also change the orientation sideways left and

right (90 and 270 degrees) by swapping rows and

columns and reversing one of them. Since we are

already reversing the columns in our original

SetPattern function, we can combine both operations

in a new SetPattern function, l ike this:

def SetPattern (rows,cols,orientation=0):

if orientation==0:

WriteToLED(~rows,ReverseBits(cols))

elif orientation==90:

WriteToLED(~cols,rows)

elif orientation==180:

WriteToLED(~ReverseBits(rows),cols)

elif orientation==270:

WriteToLED(~ReverseBits(cols), \
ReverseBits(rows))

Our routine bulked up a bit, but now we can use the

Raspberry Pi orientated at 0, 90, 1 80 and 270

degrees. Notice the default value of 0 in the definition;

we don’t even need to specify any orientation at al l , i f

the Raspberry Pi happens to be right-side up.

Back to basics

Now that we can create any pattern in positive logic

and in any orientation, it is much easier to set

individual LEDs plus columns and rows of LEDs.

def SetLED (row,col):

SetPattern(1<<row, 1<<col)

def SetColumn (row,col):

SetPattern(0xFF, 1<<col)

def SetRow (row,col):

SetPattern(1<<row, 0xFF)

On my upside-down board, I set the orientation in

SetPattern to 1 80 instead of 0.

Play time!

In Part 2 we created some test patterns to exercise

the Pi Matrix. Here are a few more. One of my

favorites is the Cylon from the TV series Battlestar

Galactica. This had a red eye that shifted position

back and forth across its face.

def MultiRowCylon (pattern,numCycles):

for count in range(0, numCycles):

for col in range(0,7):

SetPattern(pattern, 1<<col)

time.sleep(delay)

for col in range(7,0,-1):

SetPattern(pattern, 1<<col)

time.sleep(delay)

def SingleRowCylon (row,numCycles):

#Side-to-side LED chaser, single row

MultiRowCylon(1<<row, numCycles)

def AllRowCylon (numCycles):

#Side-to-side LED chaser using all rows

MultiRowCylon(0xFF, numCycles)

You can do some real ly fun animations just by

experimenting and trying different patterns. Check out

my demo video at http://youtu.be/VbPBNmlGy34.

The sample code for this month is too long to publish

in the magazine, but you can download it from

http://w8bh.net/pi/matrix3.py. (You may need to

change the ORIENTATION constant at the start of

the fi le. Also, Model B Revision 1 owners need to set

bus=smbus.SMBus(0) near the end of the fi le) .

Next time we wil l learn how to scrol l text and make a

marquee display. Have fun!

http://youtu.be/VbPBNmlGy34
http://w8bh.net/pi/matrix3.py
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DIFFICULTY : INTERMEDIATE Karl Welsh

Guest Writer

HISTORIC ARCADE GAMES
MAME - Multiple Arcade Machine Emulator

Getting MAME up and running

When Arcades Ruled

I remember the first video games arriving in the

late 1 970's. Historical ly, amusement arcades

were located at hol iday destinations and fi l led

with electro/mechanical games and pinbal l

machines dating back to the 1 950’s and 60’s.

Arcades changed with the introduction of the first

commercial ly successful ‘discrete logic’ or

‘digital ’ video game, Pong (Atari Inc: 1 972), and

then with second generation CPU powered

machines: Space Invaders (Taito/Midway:

1 978), Asteroids (Atari Inc.: 1 979), Galaxian

(Namco/Midway: 1 979), Defender (Wil l iams

Electronics: 1 980), Pac-Man (Namco/Midway:

1 980) and Donkey Kong (Nintendo: 1 981 ).

A behemoth of an industry was born. Arcade

games began appearing everywhere. Dedicated

arcades in towns and cities, game cabinets in

petrol stations, supermarkets, restaurants,

pubs/bars. I used to frequent a chip shop just

because it had Centipede (Atari Inc: 1 980).

At its peak in 1 981 , arcade games generated

annual revenues of over $5 bi l l ion in the USA

($1 2.79 bi l l ion in 201 3 dol lars) . In 1 983, the USA

endured ‘The Video Game Crash’ . Financial

markets lost faith in the 'passing fad' of video

games. The ‘Golden Age of Video Games’ was

over.

Retro gaming, emulation, and MAME

Peter De Vries, an American editor, novel ist, and

satirist wrote ‘Nostalgia isn't what it used to be’,

but I disagree. ‘Old School’ or ‘Retro Gaming’

has a substantial fol lowing and not just because

of nostalgia, but due to the restrictive/primitive

nature of the hardware. Many ‘Retro Games’ are

defined by their elegant simplicity and gameplay.

Atari Inc. co-founder Nolan Bushnel l ’s quote that

the perfect game is ‘Easy to Learn, Difficult to

Master’ describes the classics from the ‘Golden

Age of Video Games’.

An emulator is hardware or software, or both,

that duplicates the functions of one computer

system (the guest) in another computer system

(the host) , different from the first one. The

emulated behavior closely resembles the

behavior of the real system (the guest) . When

running an emulator such as MAME (Multiple

Arcade Machine Emulator) , i t may seem odd that

some games may be slower on the Raspberry Pi.

Despite the increase in processing power, 32Bit

ARM vs 8Bit Z80/6502 or 1 6Bit 68000,

emulation is VERY processor intensive. A ‘host’
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system often has to be many times more

powerful than its ‘guest’ system.

MAME was started in 1 997 by the Ital ian

programmer Nicola Salmoria, to emulate the

hardware of arcade game systems. I t was

original ly written for MS-DOS to emulate Pac-

Man, Pengo (Sega: 1 982), Crazy Climber

(Nichibutsu: 1 980), Lady Bug (Universal/Taito:

1 981 ) and Rally X (Namco/Midway: 1 980). I t

now supports over 1 0,000 ROMS (although not

al l are playable). With MAME you play the

original game code of classic arcade games

without the highly col lectable and expensive

original cabinets, or inserting any coins!

ROMS and Samples

ROM fi les wil l be required to run specific games.

There are some ROMs available for non-

commercial use at http://mamedev.org/roms/

MAME requires the correct ROM revision for

individual versions of the core program. Lucki ly,

i t wi l l display and name the missing ROM fi les,

so just try another ROM revision.

Some early arcade games used additional

‘Discrete Logic’ circuits for sound (Astro Blaster

(Sega: 1 981 ), Berzerk (Stern Electronics: 1 980),

Donkey Kong (Certain Sounds e.g. The ‘Jump’) ,

Gorf (Bal ly Midway: 1 981 ) etc). MAME cannot

Emulate these so samples are required to run

correctly.

Most games up to the mid/late 1 980s are fine,

but some require additional emulation processing

due to additional ‘Custom’ processors in the

original cabinet.

There is a l ist of some great games with the

game name, MAME code, revision required and

whether ‘samples’ are needed at:

http://www.raspberrypi.org/phpBB3/viewtopic.ph

p?f=78&t=29427

To run many of these MAME ROMs, a l icense is

required,

http://www.mamedev.org/devwiki/index.php?title

=FAQ:ROMs

Compiling AdvMAME

AdvMAME can be compiled on a 256 or 51 2

MByte Raspberry Pi. These instructions have

been tested with Raspbian Wheezy. Open a

LXTerminal window from the menu. Then before

continuing, make sure the Raspbian instal lation

is up to date,

sudo apt-get update

sudo apt-get upgrade -y

Download AdvMAME version 0.1 06.0

(advancemame-0.1 06.0.tar.gz) from,

http://sourceforge.net/projects/advancemame/fi le

s/advancemame/0.1 06.0/

This older version wil l produce better results on

the Raspberry Pi. Newer MAME releases offer

greater accuracy in emulation, but not

optimisation of performance.

Compil ing AdvMAME is resource intensive.

Therefore, before compilation use

sudo raspi-config

to disable X on boot. This wil l al low the

compilation to use the physical memory on top of

the ARM chip, rather than accessing swap space

on the SD card. With no overclocking, it wi l l take

around six hours to compile. Some overclocking

wil l improve the performance of the emulator.

Select the highest turbo overclocking mode that

is stable on your Raspberry Pi. Compilation is

possible with 64MBytes of RAM allocated to the

GPU (default setting) on a 256MByte Raspberry

Pi. I f more memory is al located to the GPU, it wi l l

start to use the swap space a lot more and may

fai l to compile. After completing the

configuration, exit raspi-config and reboot.

Login using your account and password. Instal l

the dependencies l ibsdl1 .2-dev and gcc-4.7

sudo apt-get install -y libsdl1. 2-dev \

gcc-4. 7

The gcc-4.7 compiler is needed to compile
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AdvMAME with the least additional effort. (I t is

only possible to use the standard system

compiler if several of the AdvMAME source fi les

are modified.) To use the gcc 4.7 compiler type,

export CC=gcc-4. 7

export GCC=g++-4. 7

Then unpack the AdvMAME source code,

configure it and compile:

tar xvfz advancemame-0. 106. 0. tar. gz

cd advancemame-0. 106. 0

. /configure

make

The compilation wil l take four and a half to six

hours, depending on your overclocking setting.

When the compilation has finished type

sudo make install

This is optional, but is useful as it negates the

need to change directory or set the PATH

manually.

Configuring AdvMAME

AdvMAME should be run once to setup al l the

correct folders and configuration fi les. Type

advmame

I t wi l l give you a message tel l ing you that it has

set up the default options. Now type

startx

to start X. There should now be a hidden folder

.advance in your home directory (/home/pi by

default) . I f you cannot see it, right-cl ick your

mouse and tick the ‘show hidden folders’ box.

Now download some ROMS. As an example,

the Star Fire ROM can be downloaded from

http://mamedev.org/roms/starfire/starfire.zip

Then either use the fi le manager or type

mv starfire. zip ~/. advance/rom/

to move it into place. I f the selected ROM has

samples, put those in the samples/ directory.

There is no need to uncompress them!

Next, open

. advance/advmame. rc

and add either

device_video_clock 5 - 50 / 15. 62 / 50 ;

5 - 50 / 15. 73 / 60

(on one l ine) for HDMI output or

device_video_clock 5 - 50 / 15. 73 / 60

for composite output. Then change the l ines

display_resize mixed

display_artwork_backdrop yes

display_artwork_overlay yes

to

display_resize fractional

display_artwork_backdrop no

display_artwork_overlay no

Then save and close advmame.rc. MAME can

be run from X, but using the console wil l

significantly increase the performance and

provide a ful lscreen display. Quit X.

Running MAME

Now that MAME has been ful ly configured, type

advmame Name_of_ROM

where Name_of_ROM is the name of the ROM

rather than the game title. For example,

advmame starfire

To play other games, download them and put the
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ROMs into the .advanced/rom/ directory.

Controls

Control is with the cursor keys. The fire and

jump buttons are general ly Left-Ctrl, Space and

Left-Alt respectively. Joysticks and gamepads

can also be configured and used. Al l options for

control settings, video, sound, dip switches etc.

are easi ly modified in the options menu and can

be saved for general ‘ALL Games’ or individual

games ‘This Game’. Other controls are:

5 - Add Coins

1 - 1 Player

2 - 2 Players

TAB - Options Menu (use Cursor Keys and

Enter)

ESCape - Exit

Other configuration options

MAME settings can be infinitely customised. The

defaults in advmame.rc are perfectly acceptable

for several games, but there are a few

exceptions:

1 . The default 'display_color' is ‘auto’ . Vector

games - Asteroids, Star Wars, etc. wi l l suffer

from an incorrect application error, so DON’T

change advmame.rc! In the Options Menu (TAB)

navigate to Video, Color and change ‘auto’ to

‘bgr1 6’ then ‘Save for this Game’.

2. The default 'display_mode' is ‘auto’ and

'display_magnify' is ‘1 ’ . Certain games suffer

from an incorrect application error in Aspect

Ratio (e.g. Burger Time (Data East: 1 982), I -

Robot (Atari Inc: 1 983) and Track & Field

(Konami: 1 983)) . Again, DON'T change

advmame.rc! In the Options Menu (TAB)

navigate to Video, magnify and change ‘1 ’ to ‘2’

then ‘Save for this Game’

3. Consider changing 'display_resizeeffect' from

‘auto’ to ‘none’ . Personal ly, I ’m not a fan of any of

these in emulations and they wil l be applied

when changing the magnification mode as

described above. However, they can be scrol led

through in the video options menu. Experiment,

and see if you l ike any of them!

4. I f you are old enough to remember amusement

arcades, did the SAME game seem harder in

different venues? Well , i t probably WAS! Inside

the cabinet are toggle ‘DIP’ switches that could

be set to change difficulty, l ives, extras, etc.

These are emulated in MAME and can be

configured - options (TAB), Dip Switches.

Don't Like the Command Line?

The Advance Suite of software also includes a

ful ly integrated front end for AdvMAME,

AdvMENU,

http://sourceforge.net/projects/advancemame/fi le

s/advancemenu/

A front end is a G.U.I (Graphical User Interface),

which elevates the troublesome command line

typing for emulator control and execution. The

front end can also be helpful when your ROM

collection gets larger, since it can become hard

to remember al l the MAME codes (or what

ROMS are in the folder! ) . This can be instal led

using the exact same method as MAME itself.

Then just run the executable advmenu.

Older versions, better performance

Older versions of AdvMAME can often give

improved results, but require changes to the

scripts to compile correctly on the Raspberr Pi. I

suggest downloading 0.94.0, as it requires only a

few script changes. First, modify

/advance/l inux/vfb.c. Change 'MAP_SHARED !

MAP_FIXED' to 'MAP_SHARED, ' save and

close and compile as above.

In 1 999, Bi l ly Mitchel l achieved the first

perfect PacMan score of 3,333,360 by eating

every possible dot, power pel let, fruit, and

enemy!

Steve Wiebe beat Bi l ly's 1 982 Donkey Kong

record. Many others have tried to get higher.

Hank S Chien is currenly the champion with.

1 ,1 38,600 points.
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DIFFICULTY : INTERMEDIATE John Shovic

Guest Writer

XML for the Raspberry Pi: Part 1

Introduction

This series of articles wil l discuss the use of XML on

applications for the Raspberry Pi. Part One covers

what is XML and the format of the data structures.

Part Two wil l cover bui lding and parsing XML in

Python and Part Three wil l show how XML is used as

a communications protocol for a cl ient / server

application, RasPiConnect. RasPiConnect is an

iPad/iPhone app that connects and displays

information for any number of Raspberry Pi 's via a

defined XML interface.

What is XML?

XML stands for eXtensible Markup Language. I t is a

language to structure, store and transport information

in a hardware and software independent way. I t kind

of looks l ike HTML but it is used to transport

information not to display information. HTML and

XML are both examples of an SGML (Standard

General ized Markup Language).

What do you use XML for?

I t is a l i ttle difficult to understand, but XML does not

"Do" anything. XML is designed to transport

information unl ike HTML which is used to display

information. You use XML to structure data (usual ly

in a human readable format) and to send this data to

other pieces of software on your own machine or

across the Internet. Often user preferences or user

data is also stored in XML and then written to fi les. I f

you need to send structured data, then XML is an

excel lent choice. I t is easy to parse, easy to modify,

and most importantly, easy to debug. One very

useful characteristic of XML fi les is that they can be

extended (more elements, attributes, etc.) without

breaking applications. Providing, of course, those

applications are well written (see Part Two of this

series).

Here is a complete XML message:

<?xml version="1.0" encoding="ISO-8859-1"?>

<XMLCOMMAND>

<OBJECTID>12</OBJECTID>

<OBJECTSERVERID>BL-1</OBJECTSERVERID>

<OBJECTTYPE>2048</OBJECTTYPE>

<OBJECTFLAGS>0</OBJECTFLAGS>

<RASPICONNECTSERVERVERSIONNUMBER>2.4

</RASPICONNECTSERVERVERSIONNUMBER>

<RESPONSE>

<![CDATA[100.00, 0.00, CPU Load]]>

</RESPONSE>

</XMLCOMMAND>

Structure of an XML message

Unlike HTML, in XML you define your own tags. A

well formed XML message has a "root" and then

"branches" and "leaves".

The first l ine is the XML declaration. I t rarely

changes. The second line describes the root element

of the XML document.
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<XMLCOMMAND>

Note that the end of the XML root has a closing tag:

</XMLCOMMAND>

All elements in XML must have an opening and

closing tag. This, in addition to the root is the

definition of a "well-formed XML document". By the

way, al l tags in XML are case sensitive. A good XML

coding practice is to make all of the tags uppercase.

Doing this also makes the structure of the XML stand

out when you read it.

Add child elements

Child elements are used to provide additional data

and information about the enclosing XML element

(i .e. <XMLCOMMAND> in the example above). Note

that XML does not require the same set of chi ld

elements for each enclosing XML element, making

upgrading or changing your elements easy.

However, your parser does have to handle this

situation!

Chi ld elements are XML elements underneath the

root (OBJECTID, OBJECTSERVERID, OBJECTTYPE,
OBJECTFLAGS,
RASPICONNECTSERVERVERSIONNUMBER,
RESPONSE) . Al l of these tags must have a beginning

and ending tag similar to the root. In addition, al l

elements can have chi ld elements nested inside.

XML attributes

XML elements can have attributes, just l ike HTML.

Attributes provide additional information about an

element. By convention, attributes are usual ly given

in lower case.

<PICTURE id="1" type="gif" file="BPNSCFA.gif">

</PICTURE>

I t is good practice to use attributes in XML sparingly

and in a consistent manner. You can rewrite the

above XML as the fol lowing:

<PICTURE id="1">

<TYPE>gif</TYPE>

<FILE>BPNSCFA.gif</FILE>

</PICTURE>

Not having attributes makes the parsing of the XML

easier in many ways.

XML special character secrets

There are two characters that are not al lowed inside

of an XML element. They are the "<" and "&". The

">" character is al lowed, but it is also good practice to

replace this character. The pre-defined entity

references in XML for these characters are "&lt;",

"&amp;" and "&gt;".

Sending special data in XML

Sometimes you want to send general data in your

XML element without replacing special characters.

For example, you might want to send an HTML page

inside an XML element (the RasPiConnect

application does this) and you don't want to change

all the characters. XML parses al l text inside

elements by default, but there is a way to change

that: CDATA. Inside a CDATA structure, the XML

parser ignores the data and it can be passed without

change in an XML message. CDATA looks l ike this:

<![CDATA[<XML & DOES & NOT <LIKETHIS>]]>

Validate your XML

There are many sites on the web that wil l val idate that

your XML is well formed.

http://www.xmlval idation.com is one such site. Cut

and paste the XML from the first page to try it out.

Coming in Part Two and Three

Part Two of this series wil l describe simple ways of

generating and parsing XML in Python on the

Raspberry Pi. Part Three wil l look at an actual

application and how the same XML is used on both

the iPad and directly on the Raspberry Pi.

Conclusion

XML is a simple, easi ly understood method for

sending information in a hardware and software

independent manner. The main advantages of XML

are readabi l i ty and portabi l i ty between systems. I t

provides an easi ly extensible framework for

information interchange.

To learn more about XML try the fol lowing

websites:

http://www.w3schools.com/xml/

http://www.quackit.com/xml/tutorial/

http://www.xmlvalidation.com
http://www.w3schools.com/xml/
http://www.quackit.com/xml/tutorial/


http://milocreek.com


http://swag.raspberrypi.org
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DIFFICULTY : INTERMEDIATE Martin Kalitis

Guest Writer

MY OS
Build a customised operating system

Bake your own Pi filling

By now you’ve probably tried at least one version

of an operating system on your Raspberry Pi. I f

you read issue 1 2’s article on operating systems,

you wil l real ise there are many variations in

existence.

What if you needed some customizations that are

not avai lable in the various images out there?

Perhaps you want to bui ld your very own version

for a custom purpose such as a DHCP server.

Or maybe you just want a greater understanding

of what goes into creating one of the many

software images out on the web.

This is the first in a series of

articles where we start with raw

ingredients, baking them to

perfection, producing customised

images for your Raspberry Pi.

Along the way we wil l explore the

multitude of options avai lable

and what processes are

happening under the hood.

The per-requisites for this article are as fol lows:

1 ) A PC capable of running Linux

2) Ubuntu 1 2.1 0 or 1 3.4 base instal lation and an

internet connection.

3) A SD card reader

4) A SD Card (2GB should be fine, larger is good

too:))

Bui lding Linux and all of the other components

from source code is a big job and can take many

hours; on a small computer l ike the Raspberry Pi

this could turn into days. To reduce the amount

of time this takes we wil l be using a desktop PC

running Ubuntu Linux for the job. This machine

has an Intel CPU instead of an ARM CPU and

the compilers that it uses wil l only produce

software that wil l run on an Intel system.

To overcome this problem we need to use a

compiler that is capable of creating software that

runs on the ARM CPU. This compiler is known

as a cross-compiler and is capable of creating

executable code for a CPU architecture that is

different to the one the compiler is running on.



5

There are a number of pre-bui lt options

avai lable, some free and others that attract a fee.

As we are interested in doing as much as we can

from the source code we wil l be bui lding our own.

We now have to compile. I t is important to

ensure that not only do we have all the

components needed for running Linux but that

they are also compiled in the correct order and

any fixes to each source package are applied

where appropriate. To make this easier there

are a number of tools avai lable, both open

source and commercial, that perform this

function. These tools ensure that after the hours

of bui lding the software the result wi l l run on the

Pi. We wil l be using the open source Bui ldroot

tool for compil ing our custom images in this

series of articles.

Before we can begin with creating our images,

we need to instal l a distribution on Linux on our

Desktop PC and instal l the compilers and other

tools that are used during the bui ld process to

make our images.

We start with a system that already has Ubuntu

Desktop instal led. I t does not matter if i t is a 32-

bit or 64-bit instal lation however it must be

version 1 2.04.2, 1 2.1 0 or 1 3.04. I f we are

instal l ing a fresh copy of Ubuntu onto a PC then

version 1 3.04 is recommended. Al l the

commands that we need to configure our

desktop system wil l be done from a terminal

window so open up a terminal window. Let’s get

started.

I t’s always a good idea to make sure we have a

system that is up-to-date prior to making any of

these changes. This can be accomplished with

the fol lowing command:

sudo apt-get upgrade -y

Next we instal l the compilers and other

associated tools. These wil l be used for the

compilation of the tool chain used to create the

executable binaries that the Raspberry Pi can

run.

sudo apt-get install build-essential

Next we need to instal l a few of support l ibraries

and components that wil l be used by the cross

compilation tool.

sudo apt-get install \

libncurses5-dev bison \

flex texinfo gawk

Final ly we need components

that provide the functional ity to

get the source code used to

create our final operating

system.

sudo apt-get install \

git mercurial subversion

In the next issue we wil l be using our newly

configured Ubuntu system to compile and instal l

a basic Linux system onto a SD card that we can

use on our Raspberry Pi.

DID YOU

KNOW?
The University of Cambridge Computer Lab

offers a free cource on bui lding a very

simple operating system from scratch.

They start by introducing assembly,

http://www.cl.cam.ac.uk/projects/raspberry

pi/tutorials/os/

http://youtu.be/GImeVqHQzsE
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DIFFICULTY : ADVANCED Bruce Smith

Guest Writer

LOW-LEVEL CODING
Learn how to write assember

Passing values and Add - part 2

Learn how to program your favourite computer in

its native machine code by using Assembly

Language. This is the second article in the

series. The first article was published in Issue 1 1

of the MagPi.

The ARM has a very specific and special design;

this is known as its architecture because it refers

to how it is constructed and how it looks from the

user’s point of view. Having an understanding of

this architecture is an important aspect of

learning to program Raspberry Pi’s processor.

You need to appreciate how it al l fi ts together

and how the various elements interact. In fact,

the purpose of much of the machine code we wil l

be creating is to gain access and manipulate the

various parts in the ARM chip itself.

The ARM uses a load and store architecture. I t is

very efficient at manipulating data, doing so

quickly. I t does this by using special areas of

memory bui lt inside the processor cal led

registers. Because they are on-board they are

l ightening fast in operation. For the most part,

when we program in assembler we are doing so

in User Mode – and as the sentence suggests

there are other modes avai lable. These are more

special ised and they require a degree of

programming experience to use them.

In User Mode there are 1 7 registers that can be

accessed by the programmer, as shown in

Figure 1 . In their simplest form they are

numbered 0 to 1 5 and we prefix them with an ‘R’

to indicate a register is being referred to - thus

R0, R1 , R2. Registers R0 to R1 2 are avai lable

for al l your requirements and, for the most part,

can be treated as identical. You can load,

manipulate and store information in these.

General ly these registers are used to hold an

item of data or a value that represents a location

in memory (an address).

Registers R1 3, R1 4 and R1 5 all have special

functions. R1 3 is the Stack Pointer and this

contains an address that points to an area of

memory which we can use to save information.

(This area of memory is cal led a stack and it has

some special properties we wil l look at in a future

article.) We saw R1 4 and R1 5 in action in the last

article (and in the program examples in this one)

with the instruction:

MOV R15, R14

I t’s general ly the very last one that you wil l use in
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your assembler programs. When a machine code

program is cal led from the command line, the

address cal l ing the program is placed in R1 4 –

the Link Register. (Remember that although you

are using BBC BASIC to assemble your program

it is itself being run by machine code, so we need

to know where to return to when your code has

finished executing! ) The MOV instruction moves

this saved address into R1 5 – the Program

Counter (PC). The PC is the means by which the

ARM knows where it is in a seemingly never

ending l ist of machine code instructions. I f you

corrupt the contents of the PC then your program

wil l certainly ‘freeze’, so good housekeeping in

this respect is imperative.

The 1 7th register in User Mode is cal led the

Current Program Status Register or simply,

Status Register (SR) and this register al lows you

as the programmer to test and control your

program operation – we’ l l look at this in detai l

next time.

Each of these registers can hold a value that

equates to 32-bits or four bytes in length, also

known as a word. I f you are not famil iar with bits,

bytes, words and binary numbers in general then

check out the fol lowing l ink:

www.brucesmith.info/numbers.html

Passing Values in Registers

The registers R0 through R1 2 are identical for al l

intents and purposes. Human nature being what

it is we tend to use the lower number registers

more frequently. The other advantage of this is

that we can pass values from our BBC BASIC

programs directly into registers.

When CALL is used to execute a program the

values of the integer variables A% through to H%

are passed into registers R0 to R7 respectively.

The program VARIABLETEST wil l add the

values passed to it by B% and C% and the result

is printed out using the OS_WriteC call . The

result returned is the same as last month’s

sample program.

The CALL command cannot return a value to

your cal l ing program, to do this you should use

the USR command. This is simi lar to CALL,

however it al lows you to pass a result back to

BBC BASIC from your machine code. I t uses the

format:

<variable>=USR <address>

As you can see the address, which may be a

variable, is used to identify where the machine

code is located. A variable is specified on the left

of the command, into which a value wil l be

returned. For example:

Result=USR START

The value returned in the ‘Result’ variable is that

held in R0 when the code hands control back to

BBC BASIC.

The program USRTEST modifies

VARIBLETEST slightly to add the values passed

in B% and C% storing the result in R0 so that it is

captured in the Return variable.

BREAK OUT PANEL 1:
Programs and Description

10 REM >VARIABLETEST

20 DIM CODE% (100)

30 B%=&20

40 C%=&A

50 P%=CODE%

60 [

70 . START

80 ADD R0, R1, R2

90 SWI “OS_WriteC”

100 MOV R15, R14

110 ]

120 CALL START

When the program is cal led B% and C% are

placed in R1 and R2 (l ines 30 and 40). The ADD

instruction in l ine 80 places the sum of R1 and

R2 into R0. So &20 is added to &A to give &2A,
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Line 90 uses the OS Write Character cal l to print

the contents of R0 as an ASCII character. The

ASCII character for &2A is ‘*’ .

10 REM >USRTEST

20 DIM CODE% (100)

30 B%=&20

40 C%=&A

50 P%=CODE%

60 [

70 . START

80 ADD R0, R1, R2

100 MOV R15, R14

110 ]

120 Result=USR START

130 PRINT Result

Line 90 has been deleted from the original

program. Line 1 20 has been modified to replace

CALL with USR and line 1 30 has been added to

print out the value of ‘Result’ . The value returned

is 42 which is the decimal equivalent of &2A.

BREAK OUT PANEL 2:
The ADD instruction

The ADD instruction is a very commonly used

one in ARM machine code. I t takes the format:

ADD <Destination>, <Operand1 >, <Operand2>

<Destination> is the destination register for the

result of the sum of <Operand1 > and

<Operand2>, I f you l ike:

<Destination>=<Operand1 >+<Operand2>.

The <Destination> must always be a register but

<Operand1 > and <Operand2> can be registers

or immediate values which are signified with a

hash. <Operand1 > may be the same as

<Destination>. Here are some examples:
ADD R0, R0, #1 ; Increment contents of R0 by 1

ADD R0, PC, #12; Add 12 to value of PC and save

in R0

TIP PANEL

The BBC BASIC Assembler wil l recognise both

lower and uppercase use of ‘R’ when you

reference them in your assembler. So R0 and r0

are interchangeable. The assembler wil l also

al low you to use ‘PC’ or ‘pc’ in place of R1 5, and

l ikewise ‘LR’ or ‘lr’ and ‘SP” or ‘sp” for R1 3 and

R1 4 – these being the l ink register and stack

pointer. The assembler wil l assemble these

fol lowing instructions identical ly:

MOV R15, R14

MOV pc, lr

From a programming style point of view it is best

to stick with one or the other. The advantage of

this is that you do not continual ly have to seek

out the SHIFT or CAPS LOCK key. I f you are a

proficient typist them you wil l find a combination

of upper and lower case names, say lower case

for labels, is more pleasing to the eye.

Figure 1 . Registers avai lable to the programmer

in User Mode.

Bruce Smith is an award winning author. His

book, Raspberry Pi Assembly Language

Beginners, is now avai lable from Amazon. Check

him and his book out at www.brucesmith.info for

more Raspberry Pi resources.
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Want to keep up to date with al l things Raspberry Pi in your area?
Then this section of The MagPi is for you! We aim to l ist Raspberry Jam events in your area, providing

you with a Raspberry Pi calendar for the month ahead.

Are you in charge of running a Raspberry Pi event? Want to publicise it?
Email us at: editor@themagpi.com

Preston Raspberry Jam #RJam
When: Monday 5th August 201 3 @ 7.00pm

Where: Media Innovation Studio, Media Factory, Preston, PR1 2HE

This event is free and wil l include a number of short talks and demonstrations in relation to the
Raspberry Pi. Further information and tickets avai lable at http://raspberryjam1 0.eventbrite.com

Manchester Raspberry Jam XIV
When: Saturday 1 7th August 201 3 @ 1 0.00am

Where: Madlab, 36-40 Edge Street, Manchester, M4 1 HN

The event wil l run from 1 0am unti l 5pm. Tickets avai lable to purchase at:
http://mcrraspjam.org.uk/next-event

TechnoMach Summer Event 201 3
When: Saturday 24th August @ 1 1 .00am

Where: Ysgol Bro Ddyfi , Greenfields, Machynl leth, Powys, SY20 8DR

Runs from 1 1 am unti l 3pm. Free entry but donations welcome. Further information:
http://technomach-eorg.eventbrite.com

e-day2
When: Saturday 7th September 201 3 @ 1 0.00am

Where: Gateshead Central Library, Prince Consort Road, Gateshead, NE8 4LN

The event wil l run from 1 0am unti l 3pm. Further information and free tickets are avai lable at:
http://www.eventbrite.co.uk/event/57201 451 08
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http://www.eventbrite.co.uk/event/5720145108
http://technomach-eorg.eventbrite.com
http://raspberryjam10.eventbrite.com
http://mcrraspjam.org.uk/next-event


http://www.panavise.com


22

Charm Programming on the
Raspberry Pi
SPeter N owosad
Kindle Edition

Thi s book is a ni ce companion to the Charm

articles publi shed i n The M agPi .

The book begi ns wi th an excel lent explanati on of

the di fferences between assembly and

programmi ng languages, and how they i ntereact.

Thi s i s fol lowed by the hi story of Charm, whi ch

was developed by the author of thi s book,

runni ng the RI SC OS operating system. I t i s a

charmi ng story that wi l l encourage others to play

around wi th programmi ng languages and

possi bly develop somethi ng new. The rest of the

book is a reference guide to Charm with

explanati ons of each aspect of the language and

the obligatory "H el lo world" program. The book

fini shes wi th Charm demo programs, such as

(Chi nese) checkers and hanoi . The book comes

wi th an accompanyi ng websi te (http://charm.qu-

bit.co.uk/) , whi ch contains a download reposi tory

and the abi l i ty to contact the author wi th any

queri es or suggesti ons.

Whi le some of the Engli sh language usi ng could

be qui te daunti ng to programming novices, thi s

book contains excel lent computer theory, whi ch

real ly explai ns the concept of computer

programming to the begi nner, but is sti l l vigorous

enough for the expert.

I f you are i nterested i n learni ng more about

Charm thi s i s a good reference book to add to

your Raspberry Pi /programming l i brary!
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DIFFICULTY : BEGINNER Alan Holt

Guest Writer

GET NEXT ITEM
Introducing __iter__(self)

Python iterators & generators

In this article we introduce Python iterators and

generators. In computer science, an iterator is a

container comprising a number of items. The

items themselves are arbitrary and can be any

data structure the language supports (they can

even be other iterator objects).

I terators can be processed using common

methods regardless of the nature of the items

within the iterator. In contrast, with programming

languages l ike C, l ists (arrays) are traversed by

looping through an index sequence counter or by

incrementing a pointer.

The C programmer has to know how many items

there are (or test for a nul l pointer) in order to

prevent looping beyond the end of the l ist. In

contrast, i terators provide a way of signal l ing that

the container has been exhausted, forcing the

loop to terminate.

A generator is an abstract control mechanism

that produces a sequence, returning a new value

each time it is cal led. Generators in Python

resemble regular functions. What distinguishes

regular functions from generators is that

generators rel inquish control by cal l ing yield

instead of return. This al lows generators to be

resumed later on. Generators are typical ly used

to implement iterators but they can be used to

write simple coroutines for co-operative

multitasking.

Examples

In programming languages l ike C and Pascal,

the for statement iterates over a progression of

numbers. The for-loop construct has a start value

and a termination condition (plus an optional step

value). Python’s for statement is different, in that

it i terates over a sequence (l ist, tuple or data

dictionary). To i l lustrate, run the interactive

Python interpreter and define a l ist:

>>> a = [1,2,3,4,5]

Now loop through the l ist (type CTRL-D after the

".. .") :

>>> for i in a:

... print i,

... ^D

1 2 3 4 5

Note, the trai l ing comma after the print statement

l ine ensures that each item is printed on the

same line (as opposed to separate l ines).

The for statement generates an iterator object

from the l ist by applying the iter() function. The
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resultant object has a next() method which

accesses items in the sequence one at a time. A

StopIteration exception is raised when there are

no more items. This, in turn, terminates the for-

loop. To i l lustrate, we can create an iterator:

>>> x = iter('12345')

The first cal l to the next() method returns the first

digit for the binary sequence:

>>> x.next()

'1'

Subsequent cal ls return the rest of the sequence:

>>> x.next()

'2'

>>> x.next()

'3'

>>> x.next()

'4'

>>> x.next()

'5'

A StopIteration exception is raised when we

attempt to read beyond the end of the iterator:

>>> x.next()

Traceback (most recent call last):

File "<stdin>", line 1, in <module>

StopIteration

We can loop over the iterator with the for

statement:

>>> for i in iter('12345'):

... print i,

... ^D

1 2 3 4 5

Many Python objects have bui lt-in iterators. For

example, iterators, are evident in fi le handl ing

methods. Create some arbitrary l ines of text as

data to write to a fi le:

>>> line = "Python iterators and generators"

>>> lines = "\n".join(line.split())

>>> lines

'Python\niterators\nand\ngenerators'

Now open a fi le, write the l ines of text and close

it:

>>> fd = open("title.txt", "w")

>>> fd.write(lines)

>>> fd.close()

Open the fi le again, this time for reading:

>>> fd = open("title.txt", "r")

Read each l ine of the fi le:

>>> for line in fd.readlines():

... print line.strip(),

... ^D

Python iterators and generators

Here the readlines() method returns a l ist (of

l ines), then the for statement loops through each

l ine. This could present a problem for a large fi le,

as the entire contents would be resident in

memory. Go back to the start of the fi le and cal l

the next() method a couple of times:

>>> fd.seek(0) # go back to start of file

>>> fd.next().strip()

'Python'

>>> fd.next().strip()

'iterators'

This shows that a value (in this case a line of

text) is produced each time next() is cal led. We

can read the remaining l ines with a for-loop:

>>> for line in fd:

... print line.strip() ,

... ^D

and generators

A StopIteration exception terminates the loop.

We do not see it because the exception is caught

by the for statement. We can verify the exception

is raised by call ing the next() method to read

beyond the end of the fi le:

http://youtu.be/GImeVqHQzsE
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>>> fd.next().strip()

Traceback (most recent call last):

File "<stdin>", line 1, in <module>

StopIteration

>>>

For a more graceful exit, use the try/except

statement:

>>> try: fd.next().strip()

... except StopIteration: print "end of file"

...

end of file

Writing iterators and generators

In this section we show how to write iterators and

generators. We write a function to compute

factorial to i l lustrate. The factorial of a number is

the product of al l positive integers up to and

including the number. Thus, 4 factorial is 1 x 2 x

3 x 4 = 24. Specifical ly, for this example, we are

interested in generating a sequence of factorials

from 0 to n.

Define the factorial function (either type it in at

the Python command-l ine or save it to a fi le and

import it) :

def factorial (n) :

fact = [1]

count = 1

while True:

if count > n:

return fact

else:

fact.append(fact[-1]*count)

count += 1

Note that this is not an iterator, i t is just a regular

function that produces a list of the factorials (up

to and including n). Generate the first five

factorials (0 to 4):

>>> factorial(4)

[1, 1, 2, 6, 24]

The factorial function produces a sequence (a

l ist) . We can then loop through this l ist using the

for statement:

>>> for i in factorial(4):

... print i,

... ^D

1 1 2 6 24

The complete l ist is generated on execution of

the for-loop. For long l ists, this is an inefficient

use of memory. Instead, it would be better to

generate each item of the l ist upon each iteration

of the for-loop. In short, we need an iterator

rather than a function that merely returns a

sequence. We could create an iterator with the

iter() function, but this achieves l ittle, as the

entire sequence of factorials would be created in

memory when we ran factorial() . Furthermore,

the for statement runs iter() on the sequence

anyway.

Implemented as an iterator, the factorial

operation is defined as the class below:

class Factorial:

def __init__(self,n):

self.n = n

self.fact = 0

self.count = 0

def next(self):

if self.count > self.n:

raise StopIteration

self.fact *= self.count

if self.fact < 1:

self.fact = 1

self.count+=1

return self.fact

Declare an instance of the class:

>>> f2 = Factorial (4)

Now call the next() method a couple of times:

>>> f2.next()

1

>>> f2.next()

2

>>> f2.next()

http://youtu.be/GImeVqHQzsE
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However, when we attempt to loop through it

(using a l ist comprehension construct) , an

exception is raised:

>>> f2 = Factorial(4)

>>> [i for i in f2]

Traceback (most recent call last):

File "<stdin>", line 1, in <module>

TypeError: iteration over non-sequence

Our class may have a next() method but it also

needs an __iter__() method to make it an

iterator. We simply need to add the __iter__()

method to the class:

class Factorial:

def __init__(self,n):

self.n = int(n)

self.fact = int(0)

self.count = int(0)

def next(self):

if self.count > self.n:

raise StopIteration

self.fact *= self.count

if self.fact < 1:

self.fact = 1

self.count+=1

return self.fact

def __iter__(self):

return self

Declare a new instance of the (modified) class:

>>> f3 = Factorial(4)

Now we can iterate over it, in this example, using

a l ist comprehension:

>>> [i for i in f3]

[1, 1, 2, 6, 24]

When a regular subroutine returns, its stack

frame is popped, consequently; the subroutine

cannot be re-entered. Generator functions cal l

yield() instead of return. The stack frame is

retained, enabling the generator to be resumed.

Generators are resumed by call ing next() ,

whereupon they resume from the point just after

the yield statement. Generators then continue to

execute unti l the next yield() statement is cal led.

To i l lustrate, the factorial() function above is re-

written as a generator:

def factorial(n):

fact = 1

count = 0

while True:

if count > n:

raise StopIteration

else:

if count != 0:

fact *= count

count += 1

yield(fact)

Declare an instance of the generator and iterate

over it:

>>> f4 = factorial(4)

>>> [i for i in f4]

[1, 1, 2, 6, 24]

Summary

I terators in Python provide a "get next item"

method (i .e. next()) as well as a means of

signal l ing the end of the sequence (StopIteration

exception). The inclusion of an __iter__() method

in a class provides an interface to looping

statements.

I terative procedures can be developed without

any knowledge of internal structure of the

iteration object. I terators are ideal for processing

long (or even infinite) sequences because each

item of the sequence is generated only when it is

referenced. The entire sequence, therefore, does

not have to be resident in memory.

Generators are functions that can be resumed.

The yield() statement enables a function to be

resumed each time the next() method is cal led.

Generators are, therefore, more l ike coroutines

than subroutines, and can be used for co-

operative multitasking.

http://youtu.be/GImeVqHQzsE
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